
the art 
of 
producing
an art book

Rinck J.  Heule

S E C O N D  D I G I TA L  E D I T I O N



S E C O N D  D I G I TA L  E D I T I O N

the art 
of 
producing
an art book
N O W  I N C L U D E S :

" S TA R T I N G  T H E  J O UR  N E Y  TO G E T H E R "

Copyright © 2014 by Artbookprinting.com/InnerWorkings

All rights reserved
This book may not be reproduced in whole or in part, by any means (with the 
exception of short quotes for the purpose of review), without permission of the 
copyright holder.

Content, concept and design: Rinck J. Heule 
Photography: Robert Medvedenko - M3 Studios, Grand Rapids, MI and
Christopher Schneider, Grand Rapids, MI

Image of 'dream girl' by Thinkstock - Getty Images

Editing: Nandy Heule - Heule Communications, Toronto, ON, CAN
Print management & logistics: Melissa Goggins - InnerWorkings

Designed with Adobe® CS® on a Mac Pro system
Fonts used: Neutra Text, Einstein and Didot 
Paper:  180gsm Stora Matte Art Paper
Press:  Komori Lithrone offset press

Artbookprinting.com is an InnerWorkings, Inc. company

Images of art in this book are used with permission from the artists.

All books featured in this book were produced by Artbookprinting.com.
A red dot • indicates the book was also designed at Artbookprinting.com.

Grand Rapids, MI Design & Production Studios
1-800-603-2823
www.Artbookprinting.com
Contact Rinck Heule at rheule@inwk.com

Second Edition - Printed in P.R.C

Produced in collaboration with Artron Art (Group) Co., Ltd.
Shenzhen, China
Shenzhen production team: Eric Wei and Alina Lee 

Artbookprinting.com

Web design for Artbookprinting.com by aCreativeCollective

Daniel McClintock - web developer



4

a permanent exhibition in a book
Artbookprinting.com

" My book is  
about my art,  
but also is a  
work of art! "

6	 foreword

8	 introduction

9	 why publish a book?

9	 whom can you trust with your vision?

12	 there is only one you; the importance of design

12	 capturing and reproducing your original art

17	 capturing your thoughts in writing

17	 working with Artbookprinting.com; our expectations
 
18	 the budget; dollars and sense

20	 meeting your deadline

20	 reviewing your proofs

20	 enjoying the journey

22	 a three-dimensional object

24	 everything hinges on the binding

26	 options, enhancements and embellishments

38	 ten principles of art book design

43	 STARTING THE JOURNEY TOGETHER

Souther
Art & Inspiration
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foreword 

People ask me why I choose to work for fine artists, photographers, 
galleries and musea... The most judicious clientele. 

It is because I love that challenge.  
And I excel at it.

My vision for Artbookprinting.com is for it to be  
"The finest book design and production company in the world." 

The very best in every detail. 
Books to treasure for a lifetime.

This book is dedicated to Marianna, 
my model, my muse, my love, my life.

  Kaleidoscope     Childrens of Alabama    Birmingham, AL    designed by Lindsey Vroma •  >
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1- Why publish a book?

To own an original work is a privilege you can extend to only one admirer of that work.  You can offer 
a limited edition giclée print or casting to a select few.  But creating a book will allow you to offer a 
collection of your finest work to a larger audience.  A book is a gallery they can visit and enjoy over 
and over again.

N
o other medium allows for the reproduction of images like top-quality offset printing.  But 
there is so much more to a book than the quality of the printing.  The archival-quality 
(acid-free) coated paper, the meticulously sewn signatures, the foil stamped fabric and 
wonderful three-dimensionality inherent in such a book add to an unspoken testament 
of the artist who you are.

A coffee table book is a statement of your achievement and a platform from which to launch the next 
phase of your art career.  The authority gained from publishing a book cannot be overstated.  

A limited edition book is often more sought after than a giclée print.  Many of our clients sign each copy 
of their book (often using a "signature card").

2- whom can you trust with your vision?

 
Art books and catalogues are our business and our passion.  

From serving museums and institutions for many years, we distilled a consistent combination of materials 
and processes that met the needs of even the most judicious clients.  Limiting Artbookprinting.com to 
these resources allows us to offer the finest quality in short run art book production at a quantity and 
cost that would appeal to a much larger audience. From that basis we evaluate all the enhancement 
options.

For our clients, art is their passion but also a business.  Most of our private and corporate clients have 
an audience that will absorb at least 300 copies of their book.  Most of our artists are represented by 
galleries, they offer workshops and have collectors.  

T hink of Creating your art book as hanging a gallery.  but, unlike 

a gallery inside a physical building, your art book gallery will 

 allow you to control much more than the sequence of the works, 

the color of the walls, the framing and the lighting.  you can control  

every aspect of the space itself, even the very dimensions of the space...   

Imagine... Your art book gallery will allow you to move the walls and 

even raise or lower the ceiling.  the  visitor experience is entirely under 

your artistic command.  Nothing is left to chance.

This is the experience you may expect at Artbookprinting.com

introduction



Paintings 2001-2011    Barnett Suskind    New York, NY    
designed by Tiffany Neuman •

Digital Collage      
The Digital Art of Joseph Kinnebrew    Chicago, IL    

Colleen Miller • - lead designer
Rinck Heule • - art director
Joseph Kinnebrew - creative concept and vision

a d d i n g  a  W O W  f a c t o r  metallic ink on french 
flaps and a ribbon marker that matches the signature in red foil 



12

3- There is only one you;  the importance of  book design

A
t Artbookprinting.com, everything we do recognizes that you and your art are unique to the 
world.  A book representing your art can't be made using a cookie-cutter template.  Each book 
we produce is a collaboration between a discerning artist, a professional graphic designer and a 
craftsman printer with state-of-the-art printing and binding equipment.

Of course we welcome you in our studio, but if not practical, Artbookprinting.com connects with artists via 
DESIGNLIVETM (Artbookprinting.com/designlive). This is a proprietary service that allows you to view your layout, as 
it is created, via a closed internet connection.  It literally allows you to guide your designer's hand.  You will talk one-
on-one with your designer during this process, no matter where you are located.

4- capturing your original art

The images you provide, whether transparencies or digital files, are sacred to us.  Even though we are experts 
at color management and pixel manipulation, your designer will not edit or even crop your images in any way, 
unless specifically instructed.  

Is accurate reproduction of your art not the most important feature of your book?  We recommend that you 
partner with a professional photographer to capture your original art.  

Much information is available on our web site about issues such as RGB vs CMYK color space, G7 color 
standards, InDesignTM and PDF output.  We are here to assist, and, maybe, educate you.  Not just in regards 
to important technical issues, but also about the nature of color reproduction.  We will also discuss the 
limitations and possibilities inherent in the printing process.  

Most of our clients are not experts in print.  We insist on starting the process with realistic expectations of the final 
outcome.

Paintings 2001-2011    Barnett Suskind    New York, NY    designed by Tiffany Neuman •   >
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Napoleon's Apogee    Military History Press    Chicago, IL    designed by Tiffany Neuman •

Adams County   Wilson/Johnsson Creative    Lakewood, CO    designed by Rob Johnson   >
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5- capturing your thoughts in writing

Your book is your platform to express your ideas or philosophy; to relate your experiences, to educate 
your collectors; to unveil more about your art and your skills.  Use of this space must be considered as 
carefully as the images you select to support it.  If you are not an author, we recommend that you ask 
someone to assist you in writing your text.

6- Working together with Artbookprinting.com;  our expectations

Design conceptualization is highly personal and artistic.  The page make-up (layout) of a book, on 
the other hand, follows a specific recipe that requires certain ingredients before we can begin.

You have expectations that we will not compromise the quality and that we adhere to our budget.  You 
expect us to give the project 100% of our talent and devotion.

In order to do this,  we have certain expectations of you before we can start working on your project.

W
e expect you to provide all text in a digital document, with a hard copy that has 
comments, captions and headlines marked in the margin.  You need to indicate 
where you want images placed and mark captions and comments for each image.  

We expect you to have copyright permission on the featured works.  We expect 
you to obtain permission if you intend to use song lyrics, poetry and other material that may be 
copyrighted.

We highly recommend that you pursue comments and endorsement from your peers and art critics.

We expect you to secure an ISBN number (we can assist you).

Most importantly, we expect you to decide which artworks are most suitable for this particular 
publication.

Then, when all the ingredients are in place, we can engage in the joy of collaborating on the book layout.Napoleon's Apogee    Military History Press    Chicago, IL    designed by Tiffany Neuman •
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7- meeting the budget;  Dollars and Sense

Artbookprinting.com will provide you with a detailed estimate of all cost involved in layout and design, printing, 
shipping and other costs associated with the project.

H
owever, our experience tells us that printers like us tend to use industry-specific, complex 
language that may not be familiar to you.  If there is anything in your estimate that is unclear, ask 
us before production begins.  Request paper samples and swatches.  If you have a book in your 
library that you particularly like, please allow us to take a close look at it.

Our specifications and associated prices will produce an extremely high quality book.  There are no hidden 
charges.  We can offer these prices by using standard materials and processes that have been tested for years 
among the most discerning artists, galleries and musea.  We built Artbookprinting.com on the premise that we 
could reduce production cost through the use of certain common features. 

Within this framework we can discuss many available options and embellishments.  A good example is varnish 
on the printed images.  Varnish adds lustre to the images and will seal the ink.  This effect is especially stunning 
when your images are dark in nature.  You will find samples in the pages of this book.

We recommend that you ask yourself  a few questions.  Will a better design, a larger format, hard vs soft cover, 
not only enhance the presentation but also the profit potential of my book? If the answer is yes, invest a little 
more.  If no, we recommend a more cautious approach.  While a hard cover book is a larger investment than 
a soft cover book, the retail value of a hard cover is considerably higher than a soft cover book, which often 
justifies the extra investment.

" The book looks much  
more expensive than  
what it really cost to 
produce! "

Royo    Cutter & Cutter Fine Art    St. Augustine, FL    designed by Elbandolero Lacabra
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8- meeting your deadline

P
roducing a book can be a lengthy process.  It typically takes three to four months from our first 
conference to delivery at your door.  It is critical to have a firm grip on the total production time, 
especially if you wish to have books available for an event, such as a gallery opening.  We work 
diligently to expedite the process but we will not compromise time-tested standards of quality.  
Rushing the process increases the chance that a mistake will be discovered when it is too late to 

address the issue and fix it.

If you are prepared (having all your ingredients in hand), the time needed to get ready for press will be much 
reduced and you will avoid unnecessary costs.

9- Reviewing your proofs

Why do we send you so many proofs throughout the process?  Simply, once ink flows onto paper, the opportunity 
to change anything is lost.  You will find that no comma or period will be changed by us without giving you an 
opportunity to proof it.  It will be your responsibility to carefully review every proof.

10- enjoying the journey

Our clients tell us that publishing their art book has become one of the defining moments in their careers.  Some 
have shared with us that they are sad to realize the layout is truly complete and off to be printed.  Live and enjoy 
every moment of it. 

It is a journey we look forward to sharing with you.

"YES"    America Martin    Los Angeles, CA    designed by Tiffany Neuman •
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11- A three-dimensional object

D
esigning a high quality coffee table book involves much more than creating an attractive page 
layout.  Both visible and invisible ingredients all work in harmony to enhance the reader 
experience.  More than anything, a book is a three-dimensional object.  Each element requires 
careful design consideration. 
An art book designer must be able to envision how color and finish of fabric and foil, the  

treatment of the endsheets and headbands complement the art and the page design.  Here too, the analogy 
that your book is a "portable gallery" definitely applies!

It is important for you to be familiar with some of the anatomy of a book so we can intelligently discuss how 
to make the best book possible.

b a s i c  a n a t o m y  o f  a  h a r d  c o v e r  c o f f e e t a b l e  b o o k  
( u s i n g  o u r  s t a n d a r d  f e a t u r e s )

1.	 Dust jacket
2.	 Genuine fabric over 3mm binder boards
3.	H ead and tail bands
4.	 Spine 
5.	H inge or joint
6.	F oil stamping
7.	 End sheets (front and back)
8.	 Interior or book block (one sheet of paper makes two pages)

1

2

7

8

6

4

5

3
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a sewn soft cover gallery catalog

12 Everything hinges on the binding

T 
he correct look and feel of a book depends on many factors, but nothing has more impact on the 
presentation than the binding.  

Our hard and soft cover art books are smyth sewn (named after David McConnell Smyth, 
inventor of the first flexible-sewing machine). Folded sections, called signatures, are sewn 

together, then reinforced with fabric backing and adhesive prior to casing in. It is the hallmark of quality 
binding. It allows an open book to lay flat on the table, like a coffee table book should!

We use no less than 3mm (.12”) thick warp-free boards for hard cover binding of any book over 4" x 5" in size. 

For the right client, the return on the investment in a hard cover binding can pay a very handsome dividend: 
the hard cover will demand a seven to ten times higher retail price than soft cover.

Sometimes it makes sense to do a so-called split binding. Using a common interior, part of the edition can be 
bound in soft cover and part in hard cover. Or a limited number of copies can be packaged as a Collector’s 
Edition, placing the book in a matching slipcase or a clamshell. There are numerous examples in our in-line 
portfolio.

Artbookprinting.com offers a myriad of binding options that will encourage you to think beyond the basic hard 
vs. soft cover decision. Chances are that you have never seen books bound using a Chinese Stab Binding or 
Exposed Edge Binding. These options make a unique and unusual presentation. 
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12 - options, enhancements and embellishments 

As an artist’s talent blossoms and his skills mature, the demand on his tools naturally 
increase. Only specific brands of quality brushes, paints and canvasses are allowed 
in his studio. At Artbookprinting.com, it is no different. We combine high quality, 
proven materials with tested manufacturing efficiencies. These are our basics, our 
brushes, our canvas. 

T
ogether with our client, we then begin creating that special book.  
Making your book as wonderful as your art involves exploring many 
options. The best thing is to ask as many questions as you can think of!

Here a few unique options to give you an idea of the possibilities.

a l t e r n a t i v e  b i n d i n g  o p t i o n s

1.	 Concealed spiral
2.	 Singer-sewn catalog
3.	 3/4 binding with J-card instead of dust jacket
4.	 Exposed spine hard cover 
5.	 Chinese stab binding
6.	 Conventional hard cover with exposed edges
7.	 Simple slipcase made with cardboard
8.	P rinted paper slipcase

1

2

3

4

5

6

7

8

i m a g e  e n h a n c e m e n t  
 we are experts at digital image manipulation, but we will not edit 
furnished images unless specifically instructed by the artist
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  Black Family Fine Arts Center    Dartmouth College    Hanover, NH    designed by Gregorio Amaro Jr. 28
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a ribbon marker

using both gloss and dull varnish on a page spread 
creates an amazing special effect  

  Digital Collage     The Digital Art of Joseph Kinnebrew    Chicago, IL    designed by Rinck Heule and Colleen Miller • 
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A clamshell case with 
stamping and cameo inlay

  Black Family Fine Arts Center    Dartmouth College    Hanover, NH    designed by Gregorio Amaro Jr. 
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" YOU guys WERE A
  dream tO WORK WITH! "

Sarah Yost
Archrival (Youth Marketing Agency for NBCU and Red Bull®)

Sequence    20 Years of Axis Records    Chicago, IL     designed by Yoko Uozumi    
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Coastal Zen    Sam Peck Photography    Cayucos, CA    designed by Lindsey Vroma • 
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TEN principles of ART book design

I
n modern graphic design, as in modern art, rules are made to be broken. Creativity cannot be stymied 
by archaic do’s and don’ts. But the rules (as well as the tools and media) must be mastered before they 
can be challenged effectively. Pablo Picasso had a better understanding of human anatomy than most 
medical doctors of his time.

The principles summarized below did not come from a college textbook. They were distilled from actual 
comments from our clients whose vision we helped make reality.

1.	 The design never competes for attention with the featured art. It only complements it. 

2.	F or the art to speak we force the text to step backwards. Using grey text instead of black generally helps 
create an elegant environment for the images. 

3.	 We avoid exuberant fonts. Page numbers, headers and footers must be unobtrusive or absent. Type does 
not run over images.

4.	 Each page spread is to be a new experience, building on the previous spread and inviting the reader to 
discover treasures waiting on the subsequent spread.

5.	 We respect white space. It is a critical design element.

6.	 We generally do not place more than one art image per page and sometimes just one image per spread. 

7.	 We do not bleed art images across the fold or off the edge of the page, unless such image is used as a 
section intro or a detail close-up.

8.	 We do not crop images unless specifically requested by the client.

9.	 We do not date images if the art is by a living, active artist.

10.	 We make sure our design is error-free and truly print-ready.

Once these rules are understood and adopted, we can allow creativity to be unleashed!

  Jewelry's Shining Stars     Beth Bernstein    New York, NY    designed by Hans Gschliesser  >
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[ producing a book with ArtBookPrinting.com ]

Starting The  
Journey 

Together

Dear Reader... 

Are you excited to get started? 

Maybe a bit unsure about so many details and questions?

You are not alone. Many of our clients are first time book publishers. We are here 
to accompany you.  True, this is not always an easy journey, but we will do what 
we can to make it a truly wonderful experience

To make the best of your investment of time and money, please study the follow-
ing pages carefully. Then do not be afraid to ask questions. 

When fully satisfied we are the best team to work for you, please request the 
hard copy of our book and our material selection guides, as well as the paperwork 
to get you on board as a new client.

I personally wish you a wonderful, life-changing experience with your new book.

Rinck

a permanent exhibition in a book
Artbookprinting.com
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The Green Candle   Snail Press    Los Angeles, CA    designed by Nick
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Defin i t ion of  pr int-ready 

Print ready artwork is a computer file or set of files that is created in a professional design program and 
meets a certain set of specifications.

Print ready artwork is set up to the correct size that the printer requires, has all the correct bleeds, is set 
up at the correct resolution and saved in the correct file format for that particular printers requirements.

Print ready artwork should be logically….. ready to print. This means our production staff will be able to 
open the file within their system and send it straight to color proofs without having to make any alterations 
to the files.

When to send PDF and when to send nat ive ( . INDD or  .QXD) f i les 

Inter ior  pages should come to us  in  PDF f i le  format .  Cover and jacket  f i les  should 
come to us  in  nat ive format .

Cover files and jacket files should come to us in native file format, properly packaged with all fonts and im-
ages, using the File > Package... command (INDD)  or  File > Collect for Output... command (QXD).
Native files for covers and jackets allow our technicians to tweak the files if needed for a perfect fit.

Te m p l a t e s  f o r  y o u r  c o v e r  a n d  d u s t j a c k e t

To assist you in the design of the cover and dustjacket of your book, we will provide you with templates 
based on the final production specifications. These templates can be placed in your layout file. 

P r e p a r i n g  y o u r  f i l e s  f o r  p r i n t - r e a d y  o u t p u t

Summary

The PDF file format is the most recognized and preferred format for several reasons: PDF files compress 
file size as well as include all the fonts and images of a project. If a PDF is created properly, file transfer and 
text re-flow can be avoided. We suggest using Adobe® InDesign® or QuarkXpress® for layout purposes and 
the following instructions are for these programs.

The primary advantage to the PDF format is also its primary disadvantage. The PDF format is designed to 
be essentially un-editable. Edits to text and layout must be completed before sending PDF files. This guide 
is to help you avoid additional cost. Properly generated PDF files ensure that your job prints at our best 
quality and without problems. If you have any questions about generating a PDF that this guide doesn’t 
answer, please contact one of our specialists.

SECTION        1 A :  	 Technical requirements if you provide print-ready design files  
		  If we design your book, you can skip to Section 1B on page 13 A c c e p t a b l e  f i l e  t y p e s

•	 PDF files are our preferred file type as they compress the images and text, ensuring no movement 
or re-flow. 

•	 InDesign® are accepted, please make sure to package/collect the images and fonts before submitting 
for printing. 

•	 Illustrator® and Photoshop® are accepted, however, charges will apply to insert them into a page layout  
program to create proper print-ready files.

S u p p o r t e d  S o f t w a r e

•	 Adobe® Acrobat®  (10 or lower)

•	 Adobe®  InDesign®  (CS6 or lower)

•	 Adobe®  Illustrator®  (CS6 or lower)

•	 Adobe®  Photoshop®  (CS6 or lower)

Please contact us before sending:  
Any Microsoft program, QuarkXPress®, Corel Draw® or Pagemaker®. If using any of these programs, please 
create PDFs to submit for printing. These file types may require additional billable time to process. 

F o n t  u s a g e

All screen and printer fonts utilized in your graphic and document files must be included with your files 
submitted for output. Make sure to include fonts used in any linked EPS files if they are not embedded or 
converted to curves. Knockout white type should be no smaller than 7pt.

General  PDF guidel ines

There are a few key things to remember when creating PDF files for print:

•	 All images must be converted to CMYK. RGB image files cannot be used for printing purposes.

•	 Because your images are color critical, the CMYK images should have the Coated GRACoL 
2006  profile embedded. You may download and install our ICC profile and instructions from our 
Resources page.

•	 Images need to be 300dpi at reproduction size. For example, if you want your image to print at 3”x 
6” on the printed page, the image needs to be 3” x 6” at 300dpi. If you scale this image in your layout 
6” x 9”, the relative dpi is only 150, resulting in a low-quality image.

•	 Placed PDF files will often not re-PDF properly. If you can avoid placing PDFs as art in your layout, 
please do so.

•	 We cannot add bleeds to a PDF file. (details on following page)
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Always double-check your files before sending them us. Please open them in Adobe® Acrobat® and make 
sure your text did not re-flow. Your fonts must be embedded correctly into the document. This can be 
checked under File > Document Properties in both the full version of Adobe®  Acrobat®  as well as the free 
Acrobat®  Reader® .

If you are using a full version of Adobe®  Acrobat®  you can also check your color separations. This is located 
under the Advanced Menu > Separation Preview. This is a good tool to make sure there are no spot colors 
included if your project is quoted to be full color (CMYK only). 

I n D e s i g n ®  u s e r s  PDF    g u i d e l i n e s ( M a c / PC  )

Note: While the menus will look slightly different between the Mac and PC platforms, they contain the same 
options, so the same instructions apply. If you are familiar with PDF presets, you may request one from our team.

Adobe® InDesign® can generate PDF’s in a number of ways, the easiest being Export under the File menu. 
We recommend building a PDF Style in InDesign® so you can select the same settings every time. The 
InDesign settings that we use are available on our Resources Page along with PDF instructions on how to 
install our settings on your system. Or you may follow the instructions below.

I n s t a l l i n g  s e t t i n g s

First, the Transparency Flattener needs to be adjusted. This will minimize problems with drop-shadows and 
any Transparency effects that were used. This can be accessed under Edit > Transparency Flattener Presets. 
Click “New” to enter the options. The Raster/Vector balance needs to be set all the way to Vector, the Flat-
tener resolution set to 2400dpi, and Gradient Resolution set to 300dpi. Please leave the remaining boxes 
unchecked. You can save these Flattener settings as a style, and then use them in your PDF style as well.

           

Go to File > Adobe® PDF Presets choose PDF/X-1a:2001. Name and choose where to save the file. 

Under the General tab, make sure that the Pages are set to All, and Spreads is NOT checked. Also make 
sure that none of the option boxes at the bottom of the menu are checked. 

Leave the Compression tab with the default settings.

Under the Marks and Bleeds tab, select only Crop Marks in the Printer’s Marks section, with the Weight 
and Offset to .125”. Set your Bleeds to 0.125” all the way around. 
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In the Output tab, make sure the Color Conversion is set to Convert to Destination and the Destination 
is set to Document CMYK - Coated GRACol 2006.

Under the Advanced tab, set Subset Fonts Below to 100%. Do not check any of the OPI settings. If you 
saved a Transparency Flattener Style, you can select it from the drop-down menu at the bottom. 

Security and Summary tabs can be left as is.

Last, simply select Export and choose where you want to save the PDF. Please remember to check it 
before sending it to us.
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Q u a r k XP  r e s s ®  u s e r s  PDF    g u i d e l i n e s  a n d  p r e s e t s  ( M a c / PC  )

Note: While the menus will look slightly different between the Mac and PC platforms, they contain the same 
options, so the same instructions apply.

Quark™  generates PDF’s in a number of ways, the easiest being Export under the File menu. First, go to 
File > Export > Layout As PDF. Name your file and choose where to save it. Make sure Spreads is un-
checked and Pages is set to All. Then click Options.

In the Options dialogue box, there are only a few tabs you will need to address.

First, make sure that Include Hyperlinks are NOT checked in the Hyperlinks menu.

In the Job Options tab, follow the example below.  
Make sure to Embed all fonts and keep the Compression options as is.
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The Output tab is very important for production processes. Follow the example below, set the Color Out-
put to Composite and CMYK and check Produce Blank Pages.

Registration should be set to Centered and Offset 9 pt and the Bleed type to Symmetric and .125”.

OPI settings should be active in the OPI tab as below.

You may leave Profiles as is.

Lastly, click OK in the Options dialogue box and finally, Save in the Export as PDF window. Please remem-
ber to check your files before sending them to us.

C o l o r  M a n a g e m e n t  a n d  p r o f i l e s

C o l o r  p r o f i l e s

ICC Profiles ares sets of data that characterize color of input devices and output devices, or color spaces. 
Color management is important because every device that captures or displays color can have its own 
specific profile. This includes cameras, monitors, printers, etc. Simply installing these profiles in the correct 
locations will allow your operating system and software to access them

We use the Coated GRACoL 2006 Profile. Install it if you do not have it. This will ensure that your job 
will print at our best quality with a minimum of color inaccuracies. Incorrect color management can delay 
production and incur additional costs. This section will help you install and use the ICC profiles in your 
design software. If you have any questions about the installation or loading of PDF presents that this guide 
doesn’t answer, please contact one of our specialists.

L o c a t i o n s  F o r  ICC    P r o f i l e  S t o r a g e

Once you have our ICC profiles, drag and drop the 
files into the last folder in the following locations:
 
Mac OS X
User / [username] / Library / ColorSync / Profiles

Windows XP, Windows 7, and Windows Vista
/ Windows / system32 / spool / drivers / color
After adding these to your library, you can use them 
within your design software.

U s i n g  ICC    P r o f i l e s  i n  S o f t w a r e

InDesign (Mac/PC)
Choose Edit > Color Settings...,
In the Color Settings window, click “Load...,”
Locate and select the proper .csf file.

Photoshop (Mac/PC)
Choose Edit > Color Settings...,
In the Color Settings window, click “Load...”
Locate and select the proper .csf file.

C o l o r  s p a c e s  d e f i n e d

The two basic color spaces, or Modes, that you’ll most often encounter with your digital images are RGB 
and CMYK. Each has a specific use, outlined here: RGB (Red-Green-Blue) is the color of the light emit-
ted from your computer monitor. Digital  photos, viewing onscreen, such as the internet and TV, are RGB 
color modes. RGB usually also works for printing from your home or office printer. CMYK (Cyan, Magenta, 
Yellow, Black) is the color of inks used in the offset printing process. CMYK is used for professional offset 
printing, whether it is for a gallery invite or an art book.

Computer monitors have a larger color gamut than printing that can be achieved, which is why a computer 
can display a million more colors than what can be achieved with printing. Printing deals with absorption 
and reflection of wavelengths of which we perceive as color (CMYK). Printing also has its own limited color 
gamut. A lot of times customers will note that something looked different on screen than it does on paper 
and it is because of the different limited color ranges that computer monitors and printing allows.

What color mode is your photo? In most cases, right off of your digital camera, the mode (or color space) 
will be RGB. You can tell in Photoshop by looking at the blue bar at the top of your open image (see the 
red arrow). If you need to change the mode of your image, from the top toolbar click Image/Mode/CMYK.

Changing mode can affect the appearance of your image: if you switch to CMYK from RGB, you may need 
to adjust your color.
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I m a g e  f i l e  r e q u i r e m e n t s

High-resolution digital TIFF, JPG or EPS files, typically 30MB or larger, will work best.  We can also ac-
commodate 35mm slides, 4 x 5, or 8 x 10 transparencies, Please clearly name and identify the images (title, 
medium, dimensions, etc.) and their relevant placement in the text. 

Original artwork should always be professionally photographed.   

GIF, PNG  or other files downloaded from the internet cannot be used for print. 

For printing, images have to be converted to CMYK color mode.  You can supply RGB images or RAW 
capture files, but note that color may shift when converted to CMYK.

I m a g e  e d i t i n g

We have many tools to enhance and edit images. This service is not included in your base price. Cost will 
be quoted before we begin. Note: We do not edit/enhance or even crop supplied images unless specifi-
cally instructed.

Te x t

Text must be provided in digital form. A Word™ document will work best. If you are not able to provide 
digital text, we offer typesetting services. 

Please have your document proofread before submitting. We do not proofread text or make any changes 
to your document by default. If you wish to have your document proofread we can arrange for a profes-
sional copy editor. Please ask for a quote for this service.

a raw image same image after editing

high resolution image low resolution image

SECTION        1 B :  	 Technical requirements if your book is designed in our studio  
		

An Unusual Journey   Erni Vales   Miami, FL    designed by Peter Pouridas
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Once layout is complete, you will receive a proof  (PDF). You will  have an opportunity to make edits and 
we will send you a second digital proof. Editorial changes after the second proof may constitute additional 
charges. Changes at the time of print-ready color proofs are discouraged due to high cost and  project delays .  

“ R o a d  M a p ”

We do not believe in cookie-cutter design templates, but we do require a guide or “Road Map” for our 
designer. The map indicates what text goes where and which image(s) that accompanies that text. 

R e t u r n  o f  o r i g i n a l  m a t e r i a l s

Please let us know in writing that you want original materials and media returned to you upon completion 
of the project. We back up all files, whether generated by us or provided. However, we do not guarantee 
storage beyond 90 days from completion of your project and we do not return media unless requested.

We much prefer to spend your design 

budget on the design of your book 

instead of chasing up on missing 

parts and unclear instructions. 

  Porches, Magnolias and Sweet Tea     Branning Publishing   Beauford, SC    designed by Andrew Branning
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SECTION        1 C :  	 Transferring your files  
		

You may transfer files via email if less than 10MB in size.

For files up to 2GB, please use our secure FTP site at:
https://artbookprinting.wetransfer.com

•	 Make sure to “stuff” or “zip” your files to avoid corruption during file transfer.

•	 Avoid long file names and file names with spaces as they are often unreadable.

If you prefer to send media (CD/ DVD) or have originals to be scanned, please send to:

InnerWorkings
3225 N. Evergreen NE,  Ste 201
Grand Rapids, MI 49525
616-458-8284
attn. Missy Goggins/ ArtBookPrinting.com
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The following documentation is required  
by our parent company, InnerWorkings, Inc. 

All information submitted will be held in the strictest confidence.

SECTION        2 :  	 The fine print	
	

When your investment is financially  

secure and our relationship legally sound, 

then, our creative freedom can soar!

MANAGED PRINT  SOLUTIONS
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D i s c l a i m e r  -  C o l o r  m a t c h i n g  t o  o r i g i n a l  w o r k s  o f  a r t

Your project will be printed in four-color process using offset printing technology. Offset printing provides 
the highest quality of any printing process, but it is not an exact science. 

While your project is produced on state-of-the-art equipment to the exact specifications, it is not possible 
to re-create all colors or fine details found in original works of art. Therefore, some reduction in reproduc-
tive quality is unavoidable and to be expected. We can assure you our systems are color-profiled and 
calibrated so as to reproduce the CMYK values in the digital files as accurately as possible using industry 
standard CMYK ink densities.

Monitors and printers vary from brand to brand; what you see on your monitor or print-out may not be 
what we see. Our final color proof will be your best indicator of the color you may expect when your final 
printed project is delivered. 

It is our goal not just to meet, but exceed your expectations.

MANAGED PRINT  SOLUTIONS NON   - DISCLOSU        R E  AG  R EEMENT    

THIS NON-DISCLOSURE AGREEMENT is made and entered into as of the ______ day of ________________, 2012, by and 
between _______________________________ (“Company”) with offices in ________________________ and InnerWorkings, Inc. with corporate 
offices in Chicago, Illinois (“InnerWorkings”).

Premises

1.	 Company and InnerWorkings desire to work together to advance and facilitate discussions relating to potential 
business transactions between them.

2.	 In order to facilitate such discussions, it may be necessary or desirable for each party to disclose to the other party 
certain confidential and proprietary images and text, information, data and other communications concerning the 
party’s past, current, future and proposed or potential pricing, products, services, operations, business forecasts, 
procurement requirements, plans, strategies, technologies and other information relevant to the their respective 
businesses and to the proposed transactions between them; and

3.	 Company and InnerWorkings wish to define and agree upon terms and conditions governing the confidentiality 
of material, information and data furnished and to be furnished by one party to the other in connection with their 
present and future business relationships.

Agreement

NOW THEREFORE, in consideration of the mutual covenants and undertakings expressed herein, Company 
and InnerWorkings hereby agree as follows:

1.	 Confidential Information ‑ For the purposes of this Non-Disclosure Agreement, the term “Confidential Information” 
shall mean all material, information, data and other communications of either party disclosed to or by such party 
and/or one or more of its parent, subsidiary or affiliated corporations in a manner consistent with its proprietary 
and confidential nature, and regardless of the form or medium in which such information is disclosed.

2.	 Ownership and Use ‑ All Confidential Information of either party:

(a)	 is hereby acknowledged by the receiving party to be of a proprietary nature to, and to constitute trade 
secrets of, the originating party;

(b)	 shall not be copied, used, distributed, disclosed, disseminated or communicated in any way or form by 
the receiving party whether or not for its own benefit, to anyone outside of or within its own organization, 
except to employees of the receiving party on a “need-to-know” basis, or to a third party supplier on a “need 
to know basis” who has executed a confidentiality agreement to protect any confidential information, to 
the extent necessary for: (i) completion of the negotiations, discussions and consultations with personnel 
or authorized representatives of the originating party; (ii) supplying the originating party with products or 
services at its order; (iii) preparing estimates and proposals for submission to the originating party; and (iv) 
any other purpose which the originating party may authorize in writing;

(c)	 shall not, without the express written permission of the originating party, be used by the receiving party for 
any purposes other than those set forth herein;

(d)	 shall be held by the receiving party in the strictest confidence, and shall be treated by it with the same 
degree of care to avoid disclosure to any third party as is used with respect to the receiving party’s own 
information of such importance, but, at a minimum, shall be treated with a reasonable degree of care to 
avoid any such disclosure.  The receiving party shall be liable for the disclosure of Confidential Information 
of the originating party if such care is not used.  The burden shall be upon the receiving party to show that 
such care was in fact used; and 

MANAGED PRINT  SOLUTIONS
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(e)	 is hereby acknowledged by the receiving party to be the sole property of the originating party (including 
any copyrights, trade secrets or other intellectual property rights therein) and shall be returned to the 
originating party or destroyed at the request of the originating party (including, without limitation, all 
materials, documents, drawings, models, apparatus, sketches, designs, specifications and lists, encompassing 
or evidencing same and related thereto, and all copies/formats thereof) within ten (10) days after receipt by 
the receiving party of a written request from the originating party setting forth the Confidential Information 
to be returned or destroyed.  Upon receipt of such request, the receiving party shall also erase or destroy all 
such Confidential Information of the other in any computer memory or data storage apparatus.  Immediately 
following the receiving party’s compliance with such request, the receiving party agrees, and shall certify in 
writing to the originating party, that it then retains absolutely no Confidential Information of the originating 
party in any form whatsoever.  The foregoing notwithstanding, the rights and obligations of each party with 
respect to the disclosure of Confidential Information shall survive the return or destruction of Confidential 
Information pursuant this Paragraph 2(e); and 

(f)	 may be disclosed by the receiving party if legally compelled to do so in order to satisfy any legal requirement 
of any court or competent governmental body; provided, however, that immediately upon the receiving 
party’s receipt of any such request, the receiving party shall first advise the originating party of same before 
making any disclosure to such body and, to the extent possible, provide the originating party with an 
opportunity to contest or otherwise limit such disclosure;

3.	 Exclusions ‑ The obligations set forth in Paragraph 2 hereof shall not apply, or shall terminate, with respect to any 
particular piece of Confidential Information of the originating party which:

(a)	 was in the receiving party’s possession, free of any obligation of confidence, prior to receipt from the 
originating party, as proven by the receiving party’s written records;

(b)	 is already in the public domain at the time the originating party communicates it to the receiving party, or 
becomes available to the public through no breach of this Non-Disclosure Agreement by the receiving party;

(c)	 is received independently from a third party free to disclose such information to the receiving party;

(d)	 is developed by the receiving party independently of, and without reference to, any Confidential Information 
of the originating party or any other information that the originating party has disclosed in confidence to any 
third party, as proven by the receiving party’s written records;

(e)	 is disclosed by the receiving party to a third party, with the express prior written permission of the originating party;

4.	 No Obligation ‑ Nothing contained in this Non-Disclosure Agreement shall be construed as obligating either party 
to disclose any particular information to the other party or to compel the parties to enter into any contractual 
relationship.

5.	 No Implied Licenses ‑ Except as may otherwise be provided in Section 2, nothing contained in this Non-Disclosure 
Agreement shall be construed as granting to or conferring on the receiving party, expressly or impliedly, any 
rights by license or otherwise, to the Confidential Information of the originating party or any other material, 
information or data, or any invention, discovery, improvement or product conceived, made or acquired prior to, 
on or after the date of this Non-Disclosure Agreement.

6.	 Term and Termination ‑ This Non-Disclosure Agreement shall become effective upon the day and year first above 
written, and shall remain in effect until superseded or terminated in writing by either party.  Any such termination 
notwithstanding, the rights and obligations with respect to the disclosure of Confidential Information set forth 
herein shall survive the termination of this Non-Disclosure Agreement.  Unless a longer or shorter period of 
time is agreed between the parties, the obligations of the parties under Section 2 with respect to any piece of 
Confidential Information shall terminate two (2) years after the business relationship between the parties has 
ended, as evidenced in writing by the parties.

7.	 Waiver ‑ No term or provision of this Non-Disclosure Agreement shall be deemed waived, and no breach excused, 
unless such waiver or consent shall be in writing and signed by the party claimed to have waived or consented.  
Any consent by any party to or waiver of a breach by the other, whether express or implied, shall not constitute 
a consent to, waiver of or excuse for any other, different or subsequent breach.

8.	 Severability ‑ If any term, condition or covenant of this Non-Disclosure Agreement or the application of such 
term, covenant or condition to any party or circumstance, shall to any extent be invalid or unenforceable, the 
remainder of this Non-Disclosure Agreement or the application of such term, condition or covenant to any 
parties or circumstances other than those as to which it is held invalid or unenforceable shall not be affected 
thereby, and each term, covenant or condition of this Non-Disclosure Agreement shall be valid and enforced to 
the fullest extent permitted by law.

9.	 Amendment ‑ No amendment to this Non-Disclosure Agreement shall be effective unless it is in writing and 
signed by duly authorized representatives of each of the parties.

10.	 Authority ‑ Each party acknowledges that it has full power and authority to enter into and perform this Non-
Disclosure Agreement, and that the individual executing this Non-Disclosure Agreement on behalf of each party 
has been properly authorized and empowered to enter into this Non-Disclosure Agreement.  EACH PARTY 
FURTHER ACKNOWLEDGES THAT IT HAS READ THIS NON-DISCLOSURE AGREEMENT, UNDERSTANDS 
IT, AND AGREES TO BE BOUND BY IT.

11.	 Governing Law ‑ This Non-Disclosure Agreement, and the performance hereof, shall be governed by, and 
construed in accordance with, the laws of the State of Illinois without regard to its principles of conflicts of law.

12.	 Remedies ‑ Because of the unique and proprietary nature of the Confidential Information, the parties acknowledge 
that the breach of any obligation under this Non-Disclosure Agreement may cause or threaten irreparable harm 
to the non-breaching party.  Accordingly, the parties agree that, in such event, any remedy at law for a breach 
may be inadequate and, therefore, the non-breaching party shall be entitled to seek equitable relief to protect 
its interests, including but not limited to preliminary and permanent injunctive relief as well as money damages.  
The requirements of this Section 12, Remedies, will survive any termination of this Non-Disclosure Agreement.

13.	 Entire Agreement ‑ This Non-Disclosure Agreement sets forth and constitutes the entire agreement between the 
parties with respect to the disclosures, protection and use of Confidential Information during all discussions and 
negotiations with respect to their present and future business relationships. All prior agreements, representations, 
statements, negotiations and undertakings, whether oral or written, between, or allegedly between, the parties 
with respect to the subject matter hereof are superseded by this Non-Disclosure Agreement.

IN WITNESS WHEREOF, each party hereto has caused this Non-Disclosure Agreement to be executed by its 
authorized representative with effect from the date first written above.

AGREED:					             InnerWorkings

By: 	 	 	 	
		  (Signature)			   (Signature)

Name:	 	 Name: 	
		P  rinted Name			   (Printed Name)

Its:	 	 	 Its: 	
		  Title			   Title



"YES"    America Martin    Los Angeles, CA    designed by Tiffany Neuman •
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To whom it may concern,

RE: CONSUMER PRODUCT SAFETY IMPROVEMENT ACT (CPSIA).

We appreciate you as our customer, and we are committed to providing you the very best service. We are 
also committed to using the safest materials to produce your books.
 
Congress passed Law HR 4040 concerning Lead and Phthalates content in products. We have been re-
searching this issue as it relates to the materials used to manufacture our books, especially for titles geared 
towards children 12 or younger.
 
I am pleased to report that the contents of the inks and coatings utilized in manufacturing your books are in 
compliance with all current federal regulations. Specifically, our inks have a lead content well below those 
required by the recently enacted Consumer Product Safety Improvement Act.

We have letters on file from our partner plants engaged in book manufacturing stating full compliance.

If you have any further questions, or if you would like copies of support documentation, we are happy to 
provide detailed specifications.
 
We are grateful for our partnership
 
Sincerely,

Rinck J. Heule
Managing Director
ArtBookPrinting.com

and

Senior Client Advisor
InnerWorkings

MANAGED PRINT  SOLUTIONS

T e r m s  a n d  C o n d i t i o n s

UNLESS AND TO THE EXTENT OTHERWISE SPECIFIED IN WRITING BETWEEN APPLICANT (“CUSTOMER”) AND INNERWORKINGS OR ANY OF ITS 
SUBSIDIARIES (“SELLER” or “INNERWORKINGS”), AS CONSIDERATION FOR THE ADVANCEMENT OF CREDIT, APPLICANT(S) INDIVIDUALLY, JOINTLY AND 
SEVERALLY AGREES TO THE TERMS AND CONDITIONS SET FORTH BELOW FOR ALL SERVICES AND PRODUCT (COLLECTIVELY AND INDIVIDUALLY 
REFERRED TO AS “WORK”) SUPPLIED BY INNERWORKINGS.

1. Terms of Payment – Subject to approval of Customer’s credit, net payment shall be due 30 days from invoice date unless otherwise noted in writing. If InnerWorkings 
(at its sole discretion) determines that Customer should not be extended credit, InnerWorkings may require payment in full prior to any Work or delivery, or require 
other payment arrangements satisfactory to InnerWorkings. Past-due invoices are subject to a service charge,calculated on the outstanding balance, at the lesser of 
(i) the rate of 1-ó% per month or (ii) the highest legal rate authorized by applicable law. The service charge is not intended as an alternative to payment when due, 
and upon delinquency further purchases may be declined and the Customer’s account may be referred for collection. Customer agrees to pay all costs including 
reasonable collection costs, attorney’s fees and expenses related to the enforcement of Customer’s obligations hereunder.

 2. Warranty – InnerWorkings warrants that its services shall be performed according to the terms of the applicable purchase orders accepted by InnerWorkings, and 
that its services and finished Work shall meet the generally accepted quality standards of the commercial printing industry. THIS WARRANTY IS EXCLUSIVE AND 
IN LIEU OF ANY OTHER EXPRESS OR IMPLIED WARRANTIES, INCLUDING BUT NOT LIMITED TO ANY IMPLIED WARRANTY OF MERCHANTABILITY OR 
FITNESS FOR PARTICULAR PURPOSE. 

3. Risk of Loss and transfer of title – Unless shipping has been contracted for directly by Customer, title and risk of loss of finished work shall pass to the Customer 
upon InnerWorkings’ delivery of the Work to the delivery location designated by Customer in the Purchase Order. If shipping has been contracted for by Customer, 
title and risk of loss of finished work shall pass to the Customer upon InnerWorkings’ delivery of the Work to the designated carrier. If the Purchase Order provides 
that the Work is to be delivered by the US Postal Services, title and risk of loss shall pass to the Customer upon the placement of the Work with the US Postal Service.

 4. Responsibility for Content – Customer represents and warrants that content or materials incorporated into the Work at Customer’s direction does not and will not violate 
any law or infringe any third party intellectual property rights or be defamatory to any third party, does not constitute false or deceptive advertising, does not invade any 
person’s right to privacy, and does not otherwise violate any law or infringe the rights of any third party. Customer also warrants that the content and materials incorporated 
into the Work at Customer’s direction complies with all applicable governmental regulations, including but not limited to those relating to safety. Without limiting the 
foregoing, InnerWorkings shall in no way be liable for any claim that any Work provided by InnerWorkings hereunder, or goods or services promoted or advertised by 
Work provided hereunder, failed to bear or contain all appropriate warnings, whether or not required or recommended by any governmental agency or other authority. 
 

5. Contingencies –Neither party shall be liable for any delay or failure to perform hereunder to the extent such delay or failure to perform arises out of causes beyond its 
reasonable control, including but not limited to Acts of God, labor trouble, governmental acts and regulations, inability to obtain materials or carrier space or equipment, 
or delays of suppliers or carriers. InnerWorkings shall give written notice to Customer of any such condition within five (5) business days after it arises. If InnerWorkings’ 
operations are suspended, delayed or otherwise adversely affected for any of the above causes, for a period of greater than ten (10) days, Customer shall have the right 
to terminate this Agreement and any open purchase order on written notice to InnerWorkings. Customer shall have the right in the foregoing situation to remove, and 
InnerWorkings shall promptly deliver to Customer, any and all completed Work, customer specific tooling, and uncompleted Work upon payment to InnerWorkings for 
all services rendered and materials furnished or ordered by Customer prior to the date of written notice of Customer’s election to terminate the Agreement pursuant to 
this section. If shortages occur in InnerWorkings’ supply of raw materials for reasons beyond its reasonable control, InnerWorkings may allocate its supply of raw materials 
among the customers for whom the InnerWorkings is then performing work, in such a manner and amount as shall, in InnerWorkings’ sole judgment, fairly allocate the 
supply among them. 

6. Claims / Limitation of Remedies – All claims for defective or damaged Work, or for shortages, must be made by Customer in writing fully setting forth the nature of 
the alleged defect, damage or shortage, accompanied by samples demonstrating any defect or damage, within 20 business days after Customer’s receipt thereof. 
Customer’s failure to do so shall constitute irrevocable acceptance of the goods and a waiver of any defect, damage or shortage. Claims for damage in transit must 
be made by Customer directly against the carrier. Customer’s sole and exclusive remedy for InnerWorkings’ negligence or other tort, breach of warranty or contract 
or any other claim arising out of or connected with this agreement or any purchase order between the parties shall be the return of the selling price allocable to 
that portion of the work which is nonconforming or at InnerWorkings’ option, correcting the claimed defect or damage.  IN NO EVENT SHALL EITHER PARTY BE 
LIABLE TO THE OTHER FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES, WHETHER FOR BREACH OF CONTRACT OR WARRANTY, 
NEGLIGENCE OR OTHER TORT OR ON ANY STRICT LIABILITY THEORY.

7. Bankruptcy – If Customer files for bankruptcy protection, makes an assignment for the benefit of creditors, or admits in writing its failure or inability to pay its debts 
as they become due, or becomes the subject of an “order for relief” within the meaning of that phrase in the U.S. Bankruptcy Code, or applies for or consents to 
the appointment of a receiver for any of its property, InnerWorkings may terminate any agreement or purchase order arising out of or relating to any order placed 
by Customer, at any time, effective immediately upon notice. Such termination shall not relieve either party from any obligations accrued hereunder up to the date 
of notice of termination.

 9. Waivers – No waiver by either party of any default by the other in the performance of or compliance with any provision, condition or requirement herein shall be 
deemed to be a waiver of, or in any manner release such other party from compliance with any such provision, condition or requirement in the future; nor shall any 
delay or omission of either party to exercise any right hereunder or otherwise in law in any manner impair the exercise of any such right thereafter.

 10. Governing Law / Legal Action – This Agreement and any purchase order between the parties will be governed by the internal laws of the State of Illinois. If either 
party commences an action against the other party arising out of or in connection with any agreement or purchase order between the parties, the prevailing party 
shall be entitled to have and recover from the losing party said prevailing party’s reasonable attorneys’ fees and costs of suit.

CUSTOMER’S SIGNATURE ATTESTS SOLVENCY, ABILITY AND WILLINGNESS TO PAY INNERWORKINGS’ INVOICES IN ACCORDANCE WITH THE TERMS 
ESTABLISHED. APPLICANT’S REPRESENTATIVE BY SIGNING BELOW REPRESENTS AND WARRANTS THAT SHE/HE HAS BEEN DULY AUTHORIZED TO 
MAKE THE STATEMENTS CONTAINED HEREIN AND TO BIND THE APPLICANT TO THE TERMS AND CONDITIONS SET FORTH HEREIN AND FURTHER 
REPRESENTS AND WARRANTS THAT THE INFORMATION SET FORTH ABOVE (INCLUDING, WITHOUT LIMITATION, ANY ADDITIONAL SHEETS ATTACHED 
HERETO) AND IN THE FINANCIAL STATEMENTS DELIVERED IN CONNECTION HERE WITH ARE TRUE, CORRECT AND COMPLETE.

Customer Name: ___________________________________________________________________________________________________________________________________________________________________

By (Signature): _______________________________________________________________________________________________________________________________________________________________________

Print Name: ____________________________________________________________________________________________________________________________________________________________________________

Title: ____________________________________________________________________________________________________________________Date:________/_________/_______________________________

MANAGED PRINT  SOLUTIONS
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P R EMEDIA       P R OTOCOL    

Estimates: Projects will not begin until estimate is approved. An estimate not accepted within thirty days is subject to change.

Accuracy of Specifications: Estimates are based on the accuracy of specifications provided. The design team at Artbookprinting.com, InnerWorkings™ 
PreMedia Group (IWPG), may revise estimates at the time of submission of provided materials if materials do not conform to the information on which 
the original estimate was based.

Excess Work: This is defined as any work involving additions to the original list of items defined in the project estimate or changes to all pieces 
of finished artwork after sign off by the client. If the client requires extra design requirements during a project or extra files upon completion of 
a project, the client will be informed that the alterations or changes requested fall outside the scope of the original estimate. If the client wishes 
these alterations to be made they must agree in writing, and a hourly fee will be payable.

Supplied files: It is the customer’s responsibility to maintain a copy of original files provided. IWPG is not responsible for accidental damage to 
media supplied by the customer or for the accuracy of furnished materials or final output. Until digital files can be evaluated by IWPG, no claims or 
promises are made about IWPG’s ability to work with files submitted in digital format and no liability is assumed for problems that may arise. Any 
additional translating, editing or programming needed to utilize customer-supplied files will be charged at prevailing rates.

Approval of Final Artwork: While IWPG takes extreme care to avoid errors, IWPG accepts no responsibility for typographical errors, spelling 
mistakes, or incorrect information on any project committed to print or production after customer approval. The client is to proof read and 
approve all final copy before the production of artwork. The email verification of the client shall be conclusive as to the approval of all artwork 
prior to their release for printing, implementation or installation. No refunds or reprints are given after a final approved design has gone to print 
due oversights by the client’s proof reading.

IWPG will not be held responsible for changes or amendments made after approval. It is the sole responsibility of the client to notify IWPG of 
any errors during the revision cycle and before the final files have been generated. In the event of a need to reprint due to errors in content, the 
client must inform IWPG within 3 days of product acceptance, and must return the product (at the cost of the client) within 10 days of acceptance 
for assessment.

Orders: Cancelled orders require compensation for incurred costs and related obligations. Conceptual work preformed at the customer’s request 
will be charged to the customer at IWPG current rates. This work cannot be used without written consent. Publication and/or release of work 
performed on behalf of the client by IWPG may not take place before cleared funds have been received by InnerWorkings™.

Copyright: Once a final concept is delivered to a client and full payment is received, complete ownership rights to the concept transfer to the 
client. Until then, IWPG retains full ownership of design concepts and materials it produces.  Unused concepts remain the property of IWPG. 
IWPG may still use paid-for concepts in its promotional materials and in its design portfolio. Unless the client requests otherwise, IWPG retains 
the right to display a small byline claiming design credit on works it produces, except for corporate stationery. This granting of copyright does 
not extend to the use of design proposals and concepts submitted to but not approved for the work outlined. Until final payment IWPG retains 
ownership of all artwork. IWPG reserve the rights to certain elements used to create your images including fonts, patterns, stock images, textures, 
color palettes and other non-exclusive items.

Confidentiality: It is agreed that employees of IWPG shall not at any time either during the continuance of the work outlined or thereafter, except 
in the course of their duties, divulge any of the confidential affairs of the client or any of its clients or associated companies to anyone whatsoever 
without the previous consent in writing of the client.

Disclaimer: Graphic design is a highly creative and subjective art form. As such IWPG takes every possible care with professional advice offered 
and any suggested creative concepts and/or their implementation, however the IWPG cannot be held responsible for variations between 
expectation and outcome. We strive to make your vision a reality and will do our best to make it happen!

MANAGED PRINT  SOLUTIONS

  Silva Art Design     G.A. Silva   Lexington, KY    designed by Lindsey Vroma •  
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SECTION        3 :  	 Financial documents	
	

MANAGED PRINT  SOLUTIONS

I m p o r t a n t

If you are NOT applying for an open account (net 30 days invoice)
please fill out and sign page 73 only

				O    pen accounts are not available if:
				    ° this is your first order with us
				    ° if your order is printed outside of the USA

If you are applying for an open account 
Please fill out and sign pages 72 - 75

 
All information submitted will be held in the strictest confidence.

NEW CLIENT INFORMATION

Corporate Credit Department 600 W. Chicago Suite 850, Chicago, IL 60654
Fax to: 312-604-0021

Account Name: ________________________________________________________________________________________________________________________    Date: ________/___________/___________
Add’l Trade Name(s): ___________________________________________________________________________ IW Sales Rep:  ____________Rinck Heule_______________________
Phone: _________________________________________________________________________________ Fax: _________________________________________________________________________________________
Contact Person:__________________________________________________________________ Email: _______________________________________________________________________________________

Accounts Payable Information

Billing Address*: _________________________________________________________________
City: ___________________________________________________________________________________
State: _________________________________________________________________________________
Zip Code: __________________________________________________________________________
Website: ____________________________________________________________________________
*P.O. Box not accepted

Accounts Payable Contact
Name:_________________________________________________________________________________
Title: ____________________________________________________________________________________
Phone: ________________________________________________________________________________
Address: ____________________________________________________________________________
City: ___________________________________________________________________________________
State: _____________________________________ Zip Code: __________________________

Tax Information

IRS Employer / Tax ID#:________________________________________________________________________________________________________________________________________________________
0 Taxable   0 Non-Taxable*   0 Resale Certificate #:__________________________________________________________________________________________________________
* If non-taxable please include reseller certificates / exemption letters.

Type of Business

0 Corporation   0 Partnership   0 Sole-Proprietorship   0 LLC   0 Ltd. Partnership   0 Other: _____________________________________
Date established: ___________________________________________________________ State of Incorporation:_________________________________________________________________
NAICS# _________________________________________________________________________________________________________________________________________________________________________________

Principal Officers/Owners/Partners

Name: _____________________________________________________________________Title: ___________________________________________Email__________________________________________________
Name: _____________________________________________________________________Title: ___________________________________________Email__________________________________________________
Name: _____________________________________________________________________Title: ___________________________________________Email__________________________________________________

I authorize Innerworkings to establish a new account for us and accept responsibility for all charges incurred

Name (printed): ____________________________________________________________________________________________________________________________________________________________________

Signed: __________________________________________________________________________________________________________________________________________________________________________________

Date: ______________/_________________/_________________________

MANAGED PRINT  SOLUTIONS
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APPLICATION FOR CREDIT

Corporate Credit Department 600 W. Chicago Suite 850, Chicago, IL 60654
Fax to: 312-604-0021

The following information is required to obtain credit and will be held in the strictest confidence.

Account Name: ________________________________________________________________________________________________________________________  Date: ________/___________/__________
Amount of Credit Being Requested: ________________________________________________________________________________________ Duns #: _____________________________
Add’l Trade Name(s): ___________________________________________________________________________ IW Sales Rep: ____________Rinck Heule________________________
Phone: _________________________________________________________________________________ Fax: _________________________________________________________________________________________

Accounts Payable Information

Billing Address: _________________________________________________________________
City: ___________________________________________________________________________________
State: _________________________________________________________________________________
Zip Code: __________________________________________________________________________
Website: ____________________________________________________________________________
*P.O. Box not accepted

Accounts Payable Contact
Name:_________________________________________________________________________________
Title: ____________________________________________________________________________________
Phone: ________________________________________________________________________________
Address: ____________________________________________________________________________
City: ___________________________________________________________________________________
State: _____________________________________ Zip Code: __________________________

Tax Information

IRS Employer / Tax ID#:________________________________________________________________________________________________________________________________________________________
0 Taxable   0 Non-Taxable*   0 Resale Certificate #:__________________________________________________________________________________________________________
* If non-taxable please include reseller certificates / exemption letters.

Type of Business

0 Corporation   0 Partnership   0 Sole-Proprietorship   0 LLC   0 Ltd. Partnership   0 Other: _____________________________________
Date established: ___________________________________________________________ State of Incorporation:_________________________________________________________________
NAICS# _________________________________________________________________________________________________________________________________________________________________________________

Principal Officers/Owners/Partners

Name: _____________________________________________________________________Title: ___________________________________________Email__________________________________________________
Name: _____________________________________________________________________Title: ___________________________________________Email__________________________________________________
Name: _____________________________________________________________________Title: ___________________________________________Email__________________________________________________

Bank References

Bank name: __________________________________________________________________________________________________________________________________________________________________________
Address: ________________________________________________________________________________________________________________________________________________________________________________
City: _______________________________________________________________________________________________________________________________________________________________________________________
State: _____________________________________________________________________________________ Zip Code: _____________________________________________________________________________
Phone: ___________________________________________________________________________________________________________________________________________________________________________________
Fax: _______________________________________________________________________________________________________________________________________________________________________________________

Accounts
Primary __________________________________________________________________________________________________________________________________________________________________________________
Contact: ________________________________________________________________________________________________________________________________________________________________________________
Phone/Ext.: __________________________________________________________________________________________________________________________________________________________________________

MANAGED PRINT  SOLUTIONS MANAGED PRINT  SOLUTIONS

Trade References

Firm name:____________________________________________________________________________________________________________________________________________________

Address:________________________________________________________________________________________________________________________________________________________

Annual purchase: _________________________________________________________________________________________________________________________________________

Credit limit: __________________________________________________________________________________________________________________________________________________

Contact: _______________________________________________________________________________________________________________________________________________________

Phone: __________________________________________________________________________________________________________________________________________________________

Fax: ______________________________________________________________________________________________________________________________________________________________

Firm name:____________________________________________________________________________________________________________________________________________________

Address:________________________________________________________________________________________________________________________________________________________

Annual purchase: _________________________________________________________________________________________________________________________________________

Credit limit: __________________________________________________________________________________________________________________________________________________

Contact: _______________________________________________________________________________________________________________________________________________________

Phone: __________________________________________________________________________________________________________________________________________________________

Fax: ______________________________________________________________________________________________________________________________________________________________

Firm name:____________________________________________________________________________________________________________________________________________________

Address:________________________________________________________________________________________________________________________________________________________

Annual purchase: _________________________________________________________________________________________________________________________________________

Credit limit: __________________________________________________________________________________________________________________________________________________

Contact: _______________________________________________________________________________________________________________________________________________________

Phone: __________________________________________________________________________________________________________________________________________________________

Fax: ______________________________________________________________________________________________________________________________________________________________

I authorize the release of information pertaining to this credit appliction

Name (printed): _____________________________________________________________________________________________________________________________________________________________

Signed: ____________________________________________________________________________________________________________________________________________________________________________

Date: ______________/_________________/_________________________
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SECTION        4 :  	 Good things to know 
		

Ty p i c a l  w o r k f l o w 

p r o j e c t  p a r a m e t e r s  a n d  a n a l y s i s

1.	 ABP team performs project specification analysis
2.	 ABP submits proposal and samples. Pricing detail includes freight and financial arrangement.

o n - b o a r d i n g  n e w  c l i e n t  p r o c e s s

3.	 Upon proposal acceptance, ABP sends Starting the Journey Together document
4.	 Upon return of signed documents with deposit payment, client is set up in accounting system.

5.	 ABP prepares book prototype (“white dummy”)
6.	 ABP prepares cover and jacket templates 

i f  y o u  p r o v i d e  p r i n t - r e a d y  f i l e s

7.	 Upon receipt of files, a specialist in our Grand Rapids studio preflights provided files to ensure speci-
fications are correct and for compatability with production facility(ies)

8.	 ABP uploads to plant using secure FTP site 

i f  d e s i g n e d  i n  o u r  s t u d i o

9.	 Upon receipt of images and text, ABP Grand Rapids, MI design studio provides concept and layout 
services and proofs

10.	 Digital proofs provided and signed off by client
11.	 ABP uploads to plant using secure FTP site

p r i n t i n g  a n d  b i n d i n g 

12.	 Full color hard proofs and booked-up dylux are forwarded to client for proofing
13.	 Client sends any changes or approval to begin production and/or signs off on proofs
14.	 Printing and binding or converting take place
15.	 Upon completions, two advance copies are delivered to client via FedEX Air
16.	 Upon approval ABP prepares final invoice and requests Bill of Lading
17.	 ABP contracts with freight forwarder. Shipping documents are released uppon confirmation of final 

payment
18.	 Order arrives at client’s designated final destination

C o n v e r t i n g  US   a n d  A s i a n  p a p e r  w e i g h t s

United States printers and binderies measure paper weight in pounds (lb) and points (pt) . Asian and 
European colleagues measure in millimeters (mm) and grams per square meter (gsm). Standards vary 
from country to country, but this chart will give you some of the possible conversions. 

How thick will my book be?

(PPI = Pages Per Inch)
Divide the page count by the PPI noted in the charts below. Add 0.03” to allow for gathered signatures, 
cover and glue. Example for 184 page book printed on 140 gsm matte art. 184 pages divided by 348 ppi 
equals 0.53” plus 0.03” equals a spine width of 0.56”.

GREY BOARD cover board for hardcover books
 	60 pt	 16 oz.	 1.4 mm	 1,000 gsm
 	65 pt	 20 oz.	 1.8 mm	 1,300 gsm
 	70 pt	 24 oz.	 2.0 mm	 1,400 gsm
 	80 pt	 28 oz.	 2.2 mm	 1,600 gsm
 	88 pt	 32 oz.	 2.6 mm	 1,800 gsm
 	92 pt	 36 oz.	 2.8 mm	 2,000 gsm
 	98 pt	 40 oz.	 3.0 mm	 2,100 gsm
 140 pt	 48 oz.	 3.4 mm	 2,400 gsm

MATTE COATED ART PAPER
80 gsm       651 ppi 
100 gsm     546 ppi
120 gsm     454 ppi
140 gsm     348 ppi
180 gsm     282 ppi 

GLOSS COATED ART
80 gsm       726 ppi
100 gsm     605 ppi
120 gsm     535 ppi
140 gsm     405 ppi
180 gsm     332 ppi

WOOD FREE (Uncoated)
80 gsm       552 ppi
100 gsm     462 ppi

Coated stock
GLOSS ART or MATTE ART 
	 54 lb	 80 gsm
	 61 lb          	90 gsm
	68 lb        	 100 gsm
	 82 lb        	 120 gsm
	101 lb      	 150 gsm
	122 lb      	 180 gsm
	135 lb      	 200 gsm

Uncoated stock
WOODFREE (offset) 
54 lb	 80 gsm
	68 lb	 100 gsm      
	 81 lb	 120 gsm     
	95 lb	 140 gsm
	122 lb	 180 gsm
	16 pt 	 360 gsm

Soft cover stock
10 pt		 200 gsm
12 pt		 250 gsm
14 pt		 300 gsm
16 pt		 350 gsm
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Binding Styles

Perfect (soft cover) binding: The spine roughed up and glued to the cover.
Notch binding: The spine has notches sliced into it and glue is forced into notches.
PUR glue binding: This provides a lay-flat option for a soft cover book.

Hardcover books have boards for firm, thick covers on the front, spine and back of the book. The boards 
are covered with a coverwrap. The wrap can be printed paper, genuine cloth, bonded or genuine leather.

Standard hardcover books will be bound with a square back. A rounded back will constitute additional 
cost. We also offer a lay flat binding.

More than one cover wrap may be used, as in a as in a 3-way binding.

Endpapers
are also called endsheets, or ends. They are the papers that are pasted down to the inside front and 
back cover. They are required on the construction of hardcover books. They are not necessary on 
softcover books. Endpapers can be printed or not. The paper can be plain white or a specialty paper. 

Spiral Binding
Standard plastic coil binding is ideal for cook books and instructional guide

Wire-O®
Books have a wire binding. They can be either hardcover or softcover. With a wire-O binding, left and 
right-hand pages remain aligned along the top and bottom.

Semi-Concealed Wire-O® binding:  
The spine conceals the wire. It is a good option for a book that must lay completely flat, and have a title 
that shows clearly on the spine.

Wire-O® binding on an easel:  
The easel allows the book to stand upright. It can have a hardcover or softcover. The covers and spine 
are all one. A title can show. The wire is either on the spine or on the back cover next to the spine.

A special Thank You to the great press operators around the world who make room for me in their domain.

At the crossroads where artistry and heavy-metal manufacturing meet, your magical skills a are unequalled. 
You, craftsmen (and women!) who run these giant machines, earn my deepest respect. 
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